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Abstract

FRAN is a computer-based, stand-alone, program designed to generate important
financial and operating ratios from tax and wage forms filed with the Intemal
Revenue Service. FRAN generates standard profitability, financialleverage,
liquidity/solvency, and activity ratios, as well as unique measures of workforce and
capital cost and acquisition. Information produced by the program is of use to
bankers contemplating short-term loans, to bankers and investors contemplating
extending long-term credit or taking an equity position, and to management in
securing loans and evaluating operating performance.
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What is FRAN?

Wheo Uses Financiatl
and Other Ratios?

How Many Ratios
are There?

Locating Data for
Use in FRAN

System and Software
Requirements

Installation
Procedures

FRAN is a computer-based, stand-alone program designed to generate important financial and
operating ratios. input data for FRAN can be obtained from tax and wage forms filed with the
Internal Revenue Service or extracted from a company's accounting and operating records.

Financial ratios can tell much about the operation of a business. To the banker making a short-
term cash loan, liquidity ratios reveal the firm's ability to make repayment. To the banker or
investor contempilating a long-term credit or equity position, ratios can show the firm's earning
power and/or operating efficiency. Other aspects of a business’ operation of interest to
management include inventory, accounts receivable, and workiorce tumover and capital costs.

While ratios such as those for debt/equity, workforce tumover, and capital costs immediately
convey meaningful information about a business, some work best when they are compared to
“norms” generated from previous years or from similar published figures developed for other
firms within an industry. Among the sources of financial information are: Robert Morris
Associates’ “Annual Statement Studies,” Dunn and Bradstreet's “Industry Norms and Key
Business Ratios,” the "Leo Troy Almanac of Business and Industrial Financial Ratios,” the
Bureau of the Census's “Quarterly Financial Report for Manufacturing, Mining, and Trade
Corporations,” and the Internal Revenue Service's (IRS) “Statistics of Income, Corporation
Income Tax Retum.” For a complete inventory of published ratios see Boyer and Gibson (1979).
Published ratios should be used with caution. Cunningham and Rose (1995) compared financial
ratios from Robert Morris Associates with those from Dunn and Bradstreet and found that ratios
differed significantly between the two sources even within the same industry classification. With
respect to choosing an industry norm, Keown et. al. (1924) suggested that a firm might do best
by selecting four or five companies with whom it is familiar and use available information on
these operations to establish standards for comparison.

Although many ratios can be generated, there are 15 to 20 standard financial and operating
ratios that summarize a company's performance. FRAN provides 17 traditional financial and
operating ratios pius eight measures related to workforce and capital cost and acquisition.

Additional ratios often are redundant and represent alternative ways of measuring similar
performance elements. For example, Ross et al. (1993) offered three measures that assess the
extent to which debt is utilized: debt ratio (total debt/total assets), debt-equity ratio (total debt/
total equity), and equity muitiplier (total assets/total equity). The key to understanding the links
among these measures is that total assets are equal to the sum of debt plus equity. In addition
to these ratios that are purely of a financial nature, FRAN includes measures and estimates of
operating performance of use to managers.

The RS recognizes four basic types of business: C corporation, S corporation, partnership, and
proprietorship. While each is taxed differently, all must file a tax return with the IRS. FRAN uses
the information from the appropriate tax form for these businesses to construct various financial
ratios and operating measures. The program's HELP menu includes worksheets indicating the
required information that pertains to each type as well as to its location on the appropriate 1995
IRS forms W-3, 941, 1040 Schedule C, 1065, 1120, 11208, and 4562 (see the Appendix).

For optimal performance of FRAN, we recommend the following:
*  IBM or iBM-compatible PC with at least 2 megabytes of memory
* MS-DOS version 4.01 or higher
¥ 386 processor or greater
* Hard disk drive with at least 2 megabytes of free space
* Floppy disk drive (3.5 or 5.25 inch)
*  Color monitor

Follow these steps to install FRAN:
*  if you are running Windows or Windows 95, you must go to the DOS prompt and then to the
root directory of your hard drive. To do this, type CD\ and press return.
*  Place the FRAN diskette in the disk drive and make it the current drive (type a: orb: and
press ENTER).
* Type INSTALL and press ENTER.
* Follow directions given on the screen.



Using the Program

FRAN Outputs

The main menu at the top of the screen lists File, Inputs, Window, Print, Options, and Help. In
the File submenu, the first four commands, New, Open, Close, and Name, are the most
important in using FRAN. Choose New to create a file. This brings up an output display for
entering actual values that are obtained from the appropriate IRS tax return for your firm. This
Financial Ratios and Measures screen initially shows asterisks except for the zero for average
employment, which is not a computed value.

To enter data, choose Inputs from the main menu and complete the various fields. When the
data have been entered, the Financial Ratios and Measures screen will display the constructed
ratios and measures. To save a newly created file, choose Name from the File submenu; you
may use up to eight characters in naming the file.

Should you wish to view values for a sampie file, choose Open from the File submenu and type
“example.” Do this also to retrieve any previously created and stored file using its name.

You may print only a file that is on the screen. To do so, choose Print from the main menu
(make sure that your printer is turned on to avoid an error message and/or rebooting your
computer). if you want a printout to include your name and the name of your organization, first
choose the Options menu and enter the information in the appropriate boxes. All printouts will
include the system date stored in your computer. To leave the program, choose Exit from the
File submenu.

The information sheets in the Help submenu that list the types and location of data from 1985
IRS forms that are required to use FRAN will be updated each year as necessary and
incorporated into the program. To obtain future revisions of FRAN, write to the authors at the
Northeastem Forest Experiment Station, 241 Mercer Springs Road, Princetorn, WV 24740.

The 25 financial ratios and operating measures constructed by FRAN are classified by type as
follows:
*  Profitability ratios (4)
Financing/leverage ratios (5)
*  Liquidity/short-term solvency (2)
*  Activity ratios (6)
*  Workforce measures (4)
* Capital cost and acquisition (4)

The 17 ratios or some version thereof are explained in most financial and accounting texts. The
references listed at the end of this publication and similar sources are available at you iocal
college or public library. The eight measures related to workforce and capital cost and
acquisition are unique to the FRAN program.

Interestingly, there is much disagreement and/or confusion among published texts as to how the
standard financial measures should be categorized. For example, Keown et al. {1994}
categorized both accounts receivable and inventory turnover measures twice, once as
measures of liquidity and once as profitability ratios. Asset tumover {net sales/total assets) is
categorized differentiy in three of four texts: under profitability by Keown et al. (1994), as a
liquidity measure by Hermanson et al. (1992), and as an activity ratio by Ross et al. (1893) and
Weston and Brigham (1975).

We reviewed these and other texts and their approaches to categorizing each of our financial
ratios. We wanted to place each measure in the category used by the majority of authors.
Obviously, arguments can be made for placing certain measures in other categories. What is
important is the information is conveyed by the measure itself in the overall context of a
business and its operation.



Ratios and
Performance
Measures

Prefitability Ratios

Financing/Leverage
Ratios

Gross margin on sales. Also known as gross profit, gross margin on sales is the amount that is
left after the cost of goods sold is deducted from net sales. It can be thought of as the markup on
sales. It is derived as:

[ Gross profit / net sales ]
Return on sales. Return on sales is derived as:

[ Net operating income / net sales ]
where:

Net operating income = [ (Net income - nonoperating income)
+ interest expense }

Interest expense is included in net operating income so that decisions affecting differences in
capital structure among firms are negated.

Return on assets (investment). This is a measure of return on investment (ROI) or, as defined
by Keown et al. (1994), the operating income retum on investment (OIROI). It measures the
retumn to the total investment, and indicates the eaming power of a company in terms of a
bundie of assets. This measure sometimes is calculated by dividing after-tax income by total
assets, or by dividing before-tax income and interest by total assets. For our purposes, is
derived as:

[ Net operating income / total assets ]

Return on equity. From a stockholder’s or potential investor's point of view, retum on equity is
an important measure of a company’s ability to produce income. Returmn on equity is particularly
useful when seeking to compare a firm's performance with other investment opportunities or
with other companies in the same industry. It is derived as:

[ Net operating Income / equity }

Equity ratio. This measure reveals the degree to which the overall investment is financed by
equity. A value near 1.0 indicates nearly complete owner financing, which from a creditor’s point
of view is most desirable. However, to the owner, debt can be desirable as it allows the
company to generate greater profits so long as the returns exceed the cost of debt. Likewise,
excessive debt can be dangerous, particuiarly during periods of recession. Failure to make
interest payments can force a company into liquidation. Equity ratio is derived as:

[ Equity / total assets ]

Fixed assets/equity. This measure reveals how much equity is invested in fixed assets. lts
purpose is to determine whether the investment in fixed assets has been fumnished by the
owner. Theoretically, it is preferred that owners provide all of the capital required for the plant
and some toward the daily operation of the business. The lower the ratio, the greater the degree
of liquidity and the greater the degree of autonomy for the owners. The lower the ratio, the more
owner's capital is available to meet debt obligations, payrolls, and carry receivables. it is
derived as:

[ ( Total assets - current assets )/ equity ]
Current lisbilities/equity. This measure compares what is owed by the firm in the short-term
{within a year} to what is owned by the firm. A ratio above 0.8 is considered undesirable. It is
derived as:

[ Current liabliities / equity ]

Deb¥equity. This is commonly known as the debt ratio. A value of 1.0 indicates the owners and
creditors have an equal stake in the business. Usually, the higher the debt ratio, the more



Liquidity/Short-Term
Solvency

Activity Ratios

influence creditors have over the business’ operation and the more difficult it is to borrow
additional funds. It is derived as:

[ (Long-term debt + current liabilities) / equity ]

Some analysts use only Jong-term debt to compute this ratio; they believe that short-term debts,
{i.e., current liabilities) are not part of the capital structure of the business since they are paid
within the year.

Times-interest-earned. Also known as the “interest coverage ratio,” this is a rough measure of
cash inflows versus cash outflows to cover interest expenses. The larger this ratio, the easier it
should be for a firm to meset its interest obligations. Of particular interest to creditors, this
measure is derived as:

[ (Net operating income + Interest expense) / interest expense ]

Current ratio. Also known as the “working capital” ratio, this is a measure of the liquid assets
available o meet all debts falling due within a year. it is a reflection of a company’s working
capital position. Short-term creditors are particularly interested in this ratio since inventories and
accounts receivable are the primary items from which the company obtains cash to pay short-
term credit obligations. A ratio that is too high may indicate slow-paying customers and/or siow-
moving inventories. Too many dollars needlessly tied up in current assets can affect net income.
Current ratio is derived as:

[ Current assets / current Habilities }

Quick ratio. Also known as the “acid test” ratio, this measure is similar to the current ratio in that
it indicates a firm’s ability to meet current liabilities. It differs from the current ratio in that it
excludes inventories from current assets. inventories generally are considered the least liquid of
all current assets. Their book value is sometimes overstated, especially where a quick sale
might be necessary to meet creditor demands. Consequently, the quick ratio indicates the firm's
ability to meet current liabilities without relying on the sale of inventories. it is derived as:

[ (Current assets - inventory) / current liabllities ]

Accounts receivables turnover. This is a measure of how well accounts receivable are being
serviced. The higher the ratio, the more quickly sales on account are being paid off. It is derived
as:

[ Net sales / accounts receivabie |

Collection period (days). This is a measure of how long, on average, money is tied up in credit
sales. Itis derived as:

[ Accounts receivable / (net sales / 365) ]

Inventory turnover. Similar in concept to accounts receivable turnover, inventory turnover
measures the degree to which inventories are being used. A value below the industry average
may suggest that inventories are obsolete, damaged, or otherwise difficult to move. A value
above the industry average may suggest the company is carying too little inventory and thereby
incurring larger than normal order costs, lose of quantity discounts, and stock-outs. Inventory
ratio is derived as:

[ (Net sales - gross profit) / inventory ]

Inventory (days). This is a measure of inventory in terms of daily sales. Like the collection
period for receivables, it provides another way {o view inventory activity. A value above the
industry average or above that recorded in previous periods may suggest outdated goods and
other problems. it is derived as:

[ Inventory / { (net sales - gross profit) / 365 ) ]



Workforce Measures

Capitai Cost
and Acquisition

Asset turnover. This is a measure of the efficiency with which assets are used to generate
sales. The larger the ratio, the larger the income from each doliar invested in assets. A value
below the industry average may indicate certain inefficiencies and suggest that the firm is not
generating the volume of business its investment would warrant. It is derived as:

[ Net sales / total assets }

Fixed asset turnover. This is a measure of the degree to which a firm’s fixed assets are being
utilized. A value below the industry average may suggest an underutilization of the firm's fixed
assets. A value above the industry average may suggest the firm is nearing capacity. lt is
derived as:

[ Net sales / (total assets - current assets) ]

Sales/employee This measure provides insight into the contribution of the average worker. It is
derived as:

[ Net sales / average number of employees ]

Average payroll. This measure provides an indication of average annuai employee
compensation. Differences among regions partially reflect differences in labor markets.
Differences among business types may reflect differences in employee contributions and skills.
it is derived as:

{ Payroli / average number of employees ]

Average employment. This is the average number of people employed during the year taken
directly from IRS form 941—the employer's quarterly federal tax retum.

Employee turnover. This measure indicates the rate of employee turmover. High turnover rates
usually are costly in recruitment costs and training costs and overall inefficiency. It is derived as:

[ Total number of employees / average number of employees ]

Cost of capital. A rough estimate of the average weighted cost of short- and long-term debt,
cost of capital may exclude some interest bearing obligations included among current iiability
accounts such as accounts payable. it does not indicate the current cost of capital but the
average cost of all indebtedness, past and present. Cost of capital is derived as:

[ interest expense / {long-term debt + short-term debt) }

Asset additions. This is a measure of additions 1o fixed assets expressed as a percentage of a
company's current fixed assets. It is derived as:

[ Asset additions / (total assets - current assets) ]

Asset additions/depreciation. This is a measure of the degree to which fixed asset additions
are replacing those that have been “used up.” Because of inflation and differences in the
treatment of depreciation, a value of 1.0 may not always indicate full replacement. However,
anything significantly below this value would suggest possible disinvestment while a value
significantly above 1.0 would suggest an expansion. It is derived as:

[ Asset additions / depreclation ]
Asset additions/net sales. This is a measure of the level of new investment in fixed assets in
relation to net sales. This ratio should remain fairly constant across company size as measured

by net sales. It is derived as:

[ Asset additions / net sales ]



Du Pont System

References

The Du Pont system, a frequently mentioned technique (Ross et al. 1993; Keown et ai. 1994;
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how these ratios combined to determine return on investment. The Du Pont formuia is:

Return on assets/investment = [ (Net operating Income / net sales)
* (net sales / total assets) ]

The first part of this equation is return on sales; the second is asset turnover. Thus, return on
assets, while identical for two entities, may differ significantly with regard to margin and sales
volume. For example, food retailers have a low markup but a higher volume of net sales to
assets, i.e., asset turmnover, while jewelers operate with high markup but relatively lower volumes
of net sales to assets.

The original Du Pont System has been extended to show how firms with the same return on
assets/investment can have different returns on equity due to differences in their debequity
structure. Thus, if a firm has substantial debt relative to equity (a low equity to total asset ratio),
its return on equity will be higher than a firm that is less leveraged (has less relative debt). This
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Appendix

Location of IRS Tax Form Information

C Corporation

item

Form/schedule/column’

Location?

F-1120

P-1,8-D

Total assets

Net sales F-1120 P-1,L-1c

Gross profit F-1120 P-1,L-3

Net income F-1120 P-1,L-28
Nonoperating income F-1120 P-1,SL-8,# 9, #10
interest expense F-1120 P-1,L-18

Inventory

Current assets F-1120,S-1,Cd P-4,SL-1,#2b,#3 #4,#5 #6
Current liabilities F-1120,S-L,Cd P-4,SL-16,#17,#18
Short-term debt F-1120,5-1.,Cd P-4,L-17
Long-term debt F-1120,S-1,C-d P-4,SL-19,#20,#21
Equity F-1120,S-.,C-d P-4,SL-22b,#23,#24,#25 #26
Accounts receivable F-1120,5-L.C¢c P-4,L-2a

F-1120,S-L,C-d P-4,L-3

Total number of empioyees

Average number of employees

Depreciation F-4562 P-1,L-21
Asset additions F-4562,C-c P-1,SL-15a-h, 16a-c
Total payroll F-W3 P-1,B-1

F-W3

F-941

P-1,L-1 (any quarter)

' F=forms; S=schedule; C=column.
? p=page; B=block; L=line; SL=sum of lines.



S Corporation

ftem

Form/schedule/column’ Location?

8

F-11208

&

Current assets

G

F-11208

s LR

S-L,Cd

Total assets P-1,B-E

Net sales F-1120S8 P-1,L-1c
Gross profit F-1120S P-1,L-3

Net income F-1120S P-1,L-21
Nonoperating income F-1120S P-1,5L-4,#5
Interest expense F-1120S P-1,L-13

P-4,SL-1,42b,#3,#4,#5,#6

Current liabilities

F-11208,5-L,C-d

P-4,SL-16,#17 #18

Depreciation

F-11208,6-L,C-d

Short-term debt F-11208,5-L,Cd P-4,L-17

Long-term debt F-11205,5-1.,Cd P-4,SL-19,#20,#21
Equity F-11208,8-L.,Cd P-4,8L-22,#23 #24 #25
Accounts receivable F-11205,5-L,Cc P-4,L-2a

Inventory P-4,1-3

P-1,L-21

Asset additions

Total payroll

P-1,SL-15a-h, 16a-c

Total number of employees

Average number of employees

F-941

| P-1,L-1 (any quarter)

'F=forms; S=schedule; C=column.

2 p=page; B=block; L=line; SL=sum of fines.




Partnership or Limited Liability Co.

Form/schedule/column’

Location?

TS

Interest expense

Total assets F-1065 P-1,8-f
Net sales F-1065 P-1,L-1c
Gross profit F-1065 P-1,L-3
Net income F-1065 P-1,L-22
Nonoperating income F-1065 P-1,5L-6,#7
F-1065 P-1,L-15

Depreciation

F-4562

Current assets F-1065,S-L,C-d P-4,SL-1,#2b,#3,#4,#5,#6
Current liabilities F-1065,5-.,Cd P-4,SL-15#16,#17
Short-term debt F-1065,5-L,C-d P-4,L-16

Long-term debt F-1065,5-L.Cd P-4,5L-18,#19,#20
Equity F-1085,5-L,Cd P-4,L-21

Accounts receivable F-1065,5-L,C¢c P-4\l-2a

Inventory F-1085,5-1.,Cd P-4,1-3

P-1,L-21

Asset additions

Total payroll

F-4562,C-c

F-W3

P-1,SL-15a-h, 16a-c

P-1,B-1

Total number of employees

Average number of employees

F-W3

F-941

P-1,B-c

P-1,L-1 (any quarter)

' F=forms; S=schedule; C=column.
2 p=page; B=block; L=line; SL=sum of lines.




Proprietorship

Form/schedule/column’

Total assets Not available Not available
Net sales F-1040,5-C P-1,L-3
Gross profit F-1040,5-C P-1,L-5

Net income F-1040,S-C P-1,L-29
Nonoperating income F-1040,S-C P-1,L-6
Interest expense F-1040,S-C P-1, L-16a-b

Current assets Not available , Not available
Current liabilities Not available Not available
Short-term debt Not available Not available
Long-term debt Not available Not available
Equity Not available : Not available
Accounts receivable Not available Not availabie
‘Inventory F-1040,S-C P-2.L-39

Depreciation F-4562 P-1,L-21

Asset additions F-4562, C-¢ P-1,SL-15a-h, 16a-c

Total payroli F-W3 P-1,B-1

Total number of employees F-W3 P-1,B-c

Average number of employees F-941 P-1,L-1 (
' F=forms; S=schedule; C=column.
2 P=page; B=block; L=line; SL=sum of lines.

SR

any quarter)
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